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1.0 INTRODUCTION
On a daily basis, local road agencies in South Dakota face the challenge of how to costeffectively maintain low-volume roads. Specifically, decision makers are faced with the
challenge of determining when it is most economical to maintain, upgrade, or downgrade a
road’s existing surface. For example, an agency might need to determine when it is most costeffective to convert a gravel road to a blotter road.
In order to assist decision makers with these types of questions, the South Dakota Department of
Transportation (SDDOT) initiated a research study in 2002 regarding surfacing criteria for lowvolume roads. The objective of the research study is to create a process that allows the user to
compare the costs associated with different types of roads to provide assistance in deciding
which surface type is most economical under a specific set of circumstances. In addition to
incorporating the economic factors, the process must also allow the user to consider other noneconomic factors that are more subjective and difficult to quantify, such as political factors,
growth rates, housing concentration, mail routes, and industry/truck traffic. The process that was
developed can be performed using the automated software tool that is outlined in this User’s
Guide or through the use of a manual procedure as outlined in the Technical Brief that was also
developed under this project.
This User’s Guide is a hands-on guide that introduces the macro-driven Microsoft® Excel-based
analytical tool that was developed to apply the low-volume road management methodologies
recommended under the project titled Local Road Surfacing Criteria (SD2002-10). Specifically,
this spreadsheet tool is used to determine the costs associated with maintaining roads with
different surfaces and selecting the most appropriate road surface for a specific set of
circumstances.
It is important to note that this User’s Guide is not intended to answer all questions about the
underlying analysis approach; supporting background information for this project is presented in
chapter 5 of the final report. This User’s Guide does, however, focus on providing detailed
information organized into the following four areas:
•

Analysis tool capabilities—Describes the capabilities and intended use of the decision
tool.

•

Getting started—General system requirements and step-by-step procedures for getting
started using the tool.

•

Setting up and conducting an analysis session—This section starts with a discussion of
the types of data needed to successfully define all required outputs in the analysis
methodology. The second part of this section walks a user through the analysis tool’s
user interface and the step-by-step procedure for setting up and conducting an analysis
session.

•

Explanation of output—Explanation of the produced output that summarizes all defined
inputs and the analysis output results.
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2.0 ANALYSIS TOOL CAPABILITIES
The primary purpose of this analysis tool is to provide the users with the ability to determine the
appropriate surface type for a specific roadway section based upon data relating to that section.
The tool provides a step-by-step procedure in the form of screen-by-screen progression for
making road surface type decisions between different surface materials (hot-mix asphalt [HMA],
blotter, gravel, and stabilized gravel) on low volume roadways.
The methodology incorporated into the tool is flexible enough to allow users to consider only
those costs actually incurred by the agency for maintaining their roads, to include non-agency
cost factors such as vehicle operating costs or crash potential, or to include non-economic
factors. Whatever considerations are included in the analysis, the software tool provides a
practical tool to assist agencies with decisions about the most cost-effective road surface type to
be used in various situations.
The output of an analysis includes the following:
•

Agency and user cost information summarized for the specified analysis period in a
tabular format.

•

Plot of a comparison of cumulative costs for the different surface types over the analysis
period.

•

Summary output of all input information (project description, analysis setup, agency cost
details, user cost details, and advanced user inputs).

•

Scoring table for economic and non-economic factors included in the analysis.

•

Surface type selection for a given roadway section based either upon economic factors or
a combination of economic and non-economic factors.
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3.0 GETTING STARTED
System Requirements and Recommendations
To effectively use this analysis tool, an IBM-compatible industry-standard personal computer
with the following minimum characteristics is required:
•

Intel Pentium Pro, Pentium, or 486 PC.

•

Microsoft® Windows 98, Windows 95, Windows NT 4.0, or newer operating system.

•

Minimum of 32 Mb of RAM.

•

Pointing device.

•

CD-ROM drive.

•

Super video graphics adapter with at least 800 x 600 resolution with 256 colors (Note: for
best viewing, set the display resolution to 1024 x 768 with High [16 bit] color selected).

•

Microsoft® Excel. Note: this analysis tool was developed under Microsoft® Excel 2002.

Copying the Analytical Tool to Your Computer
To use this analysis tool, first copy the SD_LowVolumeSurface.xls Excel workbook to your
computer’s hard drive. Note: you must have administrative privileges on your computer to
accomplish this task. To copy the file, complete the following steps:
1. Use Windows Explorer to create a new working directory on the computer’s hard drive
that will store the analysis tool workbook.
2. Copy the SD_LowVolumeSurface.xls file to the newly created directory.
To effectively use this analysis tool, continued administrative privileges are needed for the
created directory, so that files can be saved to that directory as necessary.
Preparing the Microsoft® Excel Environment
The SDDOT low-volume road surface selection analysis tool is a Visual Basic Application
(VBA) driven Microsoft® Excel workbook. To facilitate the entry of data, a user-friendly
dialog-box driven user interface has been incorporated to give the feel of a stand-alone software
program. However, this tool differs from stand-alone software in that it must be opened within
Microsoft® Excel. Because this analysis tool is driven by many macros (a series of commands
and functions stored in a Microsoft® Visual Basic code module), Microsoft® Excel must be set
up to allow these macros to run. To set security to an acceptable level, complete one of the
following sets of steps:
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From the “Tools” menu:
1. Under the Tools menu, click Macro.
2. Click Security from the Macro submenu.
3. Under the Security Level tab, set the macro security level to Medium.
4. Click OK to close the Security dialog box.
From the “Options” menu:
1. On the Tools menu, click Options.
2. Click the Security tab.
3. Click on the Macro Security button.
4. Click the Security Level tab, and then set the macro security level to Medium.
5. Click OK to close the Security dialog box.
6. Click OK to close the Options dialog box.
If these instructions do not appear to be valid for Excel, click on the “Help” menu and conduct a
search for “macro security.” Follow the subsequent instructions to set the macro security to
“medium.”
Starting the Analysis Tool
To start the analysis tool, simply open the SD_LowVolumeSurface.xls file like any other
Microsoft® Excel workbook. Specifically, this file may be opened by either double clicking on
the file name after using Windows Explorer to locate the file, or by opening the file using the File
=> Open menu commands within Microsoft® Excel.
Upon opening the file, the standard Excel pop-up dialog box should appear that contains the
following warning about macros:
Macros may contain viruses. It is always safe to disable macros, but if the macros are
legitimate, you might lose some functionality.
Click the Enable Macros button to allow Excel to run the macros and open the analysis tool.
Upon opening the SD_LowVolumeSurface.xls file, the macro-driven user interface will
automatically present the Introduction dialog box.
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4.0 SETTING UP AND CONDUCTING AN ANALYSIS SESSION
Introduction
This section provides the user with all of the information that is required to set up and conduct a
typical analysis session. The user interface of this analytical tool differs from a typical Microsoft
Excel spreadsheet in that a series of dialog boxes (windows) are presented to the user to collect
needed inputs for the analysis process. That is, you will enter inputs using typical Windows
controls (i.e., typing values in input boxes, selecting values from drop down list boxes, clicking
check boxes, etc.) rather than entering values into cells in a traditional spreadsheet. The
intention of this dialog box-driven user interface is to facilitate the gathering of required inputs
and to make the analysis process more user friendly.
Specifically, the user interface of the analysis tool is organized into a series of required and
optional steps that are completed to conduct an analysis. An overall flow chart showing the
general structure of the user interface is presented in figure 1. Each step of the setup process is
discussed in more detail in the separate sections below.
Introduction

General Cost Analysis
Setup

Agency Cost Details

User Cost Details
(optional)

Cost Analysis Results

Scoring Table for Economic
and Non-Economic Factors
(optional)

Figure 1. General structure of the analysis tool’s user interface.
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Introduction Dialog Box
When you first open the start the SD_LowVolumeSurface.xls workbook, you will be presented
with the Introduction dialog box displayed in figure 2. This dialog box introduces the user to the
analytical tool, provides controls where the user can enter some general project description
information, and determines the level of analysis complexity that the user will be subjected to
throughout the remainder of the analysis setup process. More details on the specific areas and
controls included on this dialog box are described below.

Figure 2. Introduction dialog box.
Project Description Information Area
The Project Description Information area of this dialog allows you to define some identifying
information about the current project for which you are analyzing potential surface types. The
following input boxes allow you to enter project-specific information that helps identify the
project:


Road name—Use the Road name to store an identifying road name, highway number, or
project ID associated with a given project (e.g., County Road A). To change the current
defined road name, simply type a new name in the Road name input box.
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Location—The Location input box is intended to store more detailed identifying
information that can be used to identify the specific location associated with a given
project (e.g., 5 mile section from Grant Road to SD Highway 7).



County—The County drop-down list box contains an alphabetical list of counties in the
State of South Dakota. As another piece of project identifying information, select the
appropriate county from the County list box.

Advanced User Inputs Area
The Advanced User Inputs area contains a check box that, if checked, will allow a more
advanced user access to some of the underlying defaults associated with the cost analysis. When
conducting a typical surface selection comparison, it is strongly recommended that you leave the
Enable “Advanced User” Inputs check box unchecked. In general, the default values that are
made available to advanced users do not need to be changed as they are values recommended by
the research team and Technical Panel associated with this project. The more detailed cost
analysis variables made available to “advanced users” should only be changed when conducting
more complex “what if-type” analysis sessions.
Development Information Area
The Development Information area of this dialog simply provides the user with contact
information relevant to this analysis tool.
Next Button
As mentioned above, the user interface for this workbook is laid out as a sequential series of
dialog boxes that are used to gather the required inputs for an analysis. Clicking on the
button will display the next dialog box in the series (i.e., General Cost Analysis Setup).
Help Buttons
If at any point during the setup of the analysis session more detailed information associated with
a dialog box’s purpose, controls, or inputs is needed, click on the provided
button to view
specific help text.
Closing the Workbook Without Saving
If you would like to close (exit) the workbook without saving any of your changes, you may do
) in the upper right corner of any primary dialog
this by clicking the close window box (i.e.,
box in the user interface. Clicking this button will bring up the Exiting the Program dialog box
shown in figure 3. The
and
buttons provided on this dialog box are
described below.


The
button closes the analysis tool workbook without saving any changes
made to the current session. Inputs are only saved as part of the new workbook that is
created as a result of conducting an analysis session.
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The
button returns the user to the user interface. The analysis tool workbook
will not be closed, and therefore any input changes will not be lost.

Figure 3. Exiting the Program dialog box.
General Cost Analysis Setup Dialog Box
The General Cost Analysis Setup dialog box (shown in figure 4) provides controls used to collect
some of the more general required cost analysis-related inputs. The dialog box is divided into
four different areas titled Analysis Type, Selection of Alternative Surface Types, Analysis Setup
Inputs, and Inclusion of User Costs. Each of these different input areas is described in more
detail below.

Figure 4. General Cost Analysis Setup dialog box.
Setting the Analysis Type
As explained in the introductory text in the Analysis Type area of this dialog box, this analytical
tool may be used to help select a surface type for either a new construction project or a project in
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which the current surface is being upgraded or downgraded. Choose the appropriate analysis
type from the Analysis type drop down list box.
Selecting the Surface Types to be Considered in the Analysis
For a given analysis, the user has the option to choose which of the four available surface types
(Hot-Mix Asphalt [HMA], Blotter, Gravel, and Stabilized Gravel) are to be considered for a
given project. The controls in the Selection of Alternative Surface Types area of the General
Cost Analysis Setup dialog box are used to define the surface types to be included in the analysis
session. To include a particular surface type in the analysis, click on the surface type name or its
associated check box to enable it. To disable a previously selected surface type, click again on
the surface type name or check box.
Defining General Cost-Related Analysis Setup Inputs
The four inputs contained in the Analysis Setup Inputs area of the General Cost Analysis Setup
dialog box are grouped together as they are project-related inputs that directly influence the cost
analysis. Brief descriptions of each of these inputs are presented below.
 Project length—Use this input box to enter the length of the project that you are
investigating. The primary importance of this input is that it is used to translate any costs
entered as total project costs, to a unit cost per mile. For example, if the user defined a
project that was 5 miles in length, and entered an annual total project maintenance cost of
$5,000, the cost analysis would translate this total cost into a unit cost of $1,000 per mile
(i.e., $5,000/5 miles = $1,000 per mile). All cost-related results from the cost analysis are
presented in standard units of dollars per mile.
 Road width—The width of the road is used to convert the cost of a treatment that is
provided on a square foot basis to a unit cost per mile.
 Average daily traffic (ADT)—The average daily traffic is important for two reasons.
First, all treatment frequency and cost information collected from South Dakota
personnel as part of this project was specific to a given ADT. That is, the typical
maintenance treatment schedules for gravel surfaces with ADTs of 100 and 1000,
respectively, are most likely different. Therefore, if you are interested in using default
treatment timing, frequency, and cost data collected in the state of South Dakota under
this project, the analytical tool needs to know the ADT associated with your current
project. Second, if you choose to include user costs in the analysis, the number of
vehicles using that road directly influences these costs. The optional use of user costs is
described in more detail below.
 Urban or Rural setting—Use this drop down list box to select whether your project is
located in an urban or rural setting.
Inclusion of User Costs
User costs typically refer to the vehicle operating, crash, and delay costs incurred by the users of
a facility. During a life-cycle cost analysis, some or the entire user cost portions may be used in
the analysis depending upon the desires of the agency. For this study, a decision was made to
only include the vehicle operating and crash components of the user costs in the life-cycle cost
analysis. Brief descriptions of each of these cost types are as follows:
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Vehicle operating costs (VOC)—In the analytical tool, vehicle operating costs are
computed as a function of surface type, number of vehicles (by vehicle type), vehicle
speed, and road grade. The vehicle operating cost data used as the basis of these
calculations are based on industry averages for the cost of operating vehicles on paved
surfaces that are converted based upon the different factors.



Crash costs—Crash costs refer to the costs to society as a whole associated with roadway
crashes. As is typically done, the crash costs computed in the analytical tool are
categorized into costs associated with fatalities, non-fatal injuries, and property damage.

Including user costs in your analysis session is completely optional. If you wish to include user
costs, click the check box in the Inclusion of User Costs area to enable it. If you wish to exclude
user costs from your analysis session, make sure that this check box is not selected when
proceeding to the next dialog box. If you choose to include user costs, you will be asked to enter
more specific user cost-related inputs at a later stage of the analysis setup procedure. If you
choose not to include user costs, all user cost-related inputs will be hidden throughout the
analysis setup process.
Agency Cost Details Dialog Box
The Agency Cost Details dialog box (shown in figure 5) provides controls that are used to define
all of the maintenance treatment timing, frequency, and costs associated with the different
surface types included in the analysis. Note that a separate tab is displayed for each of the
surface types previously selected on the General Cost Analysis Setup dialog box. While the
maintenance treatments differ between the surface types, the controls and general layout of the
different surface-related tabs use the same format. The details associated with defining the
maintenance treatment-related inputs are discussed below.
Defining Initial Costs
The first input at the top of each surface-specific tab is the initial cost of placing the surface
treatment. This initial cost is either the total project cost or unit cost (cost per mile) associated
with a particular surface type. If you previously selected the analysis type to be New
Construction, the initial cost is the total or unit cost associated with placing that new surface. If
you selected an analysis type of Upgrade/Downgrade, this initial cost typically represents the
cost of the last major rehabilitation on an HMA surface, last seal coat on a blotter surface, or last
regraveling on both gravel and stabilized gravel surfaces. You may also add any costs associated
with upgrading a road from one surface type to another to meet existing road standards.
To define the initial cost for a given surface type, simply type the representative cost in the
appropriate input box and select the units (either total cost, cost per mile, or cost per square foot)
from the associated unit drop down list box. Those users wishing to include the cost of curb and
gutter for urban roads should include that cost within the initial construction/last major
rehabilitation cost.
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Figure 5. Agency Cost Details dialog box (showing controls associated with an HMA-surfaced
pavement).
Defining Maintenance Treatment Timing and Cost Details
The controls in the Maintenance Treatment Timing and Cost Details area of the Agency Cost
Details dialog box allow you to define which maintenance treatments are to be applied to a given
surface type, when they are to be applied, and how much they are going to cost.
Selecting the Maintenance Treatments to Apply
The first step in setting up a maintenance strategy is determining which maintenance treatments
are to be used on each included surface type. Table 1 summarizes the different maintenance
treatments that are commonly used on low volume roads in South Dakota.
To include a particular maintenance treatment as part of a particular maintenance strategy, click
on the maintenance treatment name or the check box next to the treatment name to check the
box. To deselect a particular maintenance treatment that is checked, simply click on the name or
associated check box again to uncheck the box. Note, if you choose to include the Overlay
maintenance treatment for the HMA surface type, you are asked to enter an overlay thickness (in
inches) into the input box provided to the right of the Overlay name.
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Table 1. Available maintenance treatments for HMA, blotter, gravel and stabilized gravel
surfaced roads.
Surface Type
Hot-mix asphalt
(HMA)

Blotter

Gravel

Stabilized Gravel




















Available Maintenance Treatments
Crack sealing
Seal coat
Overlay
Striping and marking
Patching/maintenance
Seal coat
Striping and marking
Patching/maintenance
Process in place, add aggregate, and reblot
Blading
Regravel
Reshape cross section
Spot gravel/maintenance
Dust control
Blading
Regravel
Reshape cross section
Spot gravel/maintenance

To include one of the user definable Other fields, first click the associated check box to enable
the Other maintenance treatment field, and then enter a descriptive maintenance treatment name
in the text box directly to the right of the associated check box.
Defining the Timing and Frequency of the Included Maintenance Treatments
The second set of inputs in the Maintenance Treatment Timing and Cost Details area of the
Agency Cost Details dialog box allow you to define the timing and frequency of each included
maintenance treatment for a given surface type. The inputs are organized so that you can read
the description of timing and frequency from left to right after you define values in the input
boxes associated with the number of times a year the particular treatment is applied, how often
the treatment(s) is to be applied (in terms of years), and the year at which the first application is
to be applied. For example, if you wanted to schedule one seal coat every 4 years, starting in
year 7, you would set the Seal Coat treatment line to read “Applied 1 time(s)/yr every 4 years
starting in year 7.” As another example, if you wanted to reblade a gravel road 4 times a year,
every year, starting in year 1, you would set the Blading line to read “Applied 4 time(s)/yr every
year starting in year 1.”
Defining Maintenance Treatment Unit Costs
The final set of inputs in the Maintenance Treatment Timing and Cost Details area of the Agency
Cost Details dialog box are used to define the cost associated with applying one application of a
particular maintenance treatment. To define the cost of a particular treatment application, type
the cost in the input box and set the corresponding cost units to either dollars per application
($/app), dollars per mile ($/mile) or dollars per square foot ($/sq ft). Note that when choosing
12

units of “$/app,” the cost that is expected is the total cost of applying one application of the
maintenance treatment over the entire project length. For example, assume that a seal coat costs
$5,000 per mile and is applied on a 4 mile long project. Such a cost could be entered as
“$20,000 per app” or as “$5,000 per mile.” Both cost descriptions would be equivalent in the
cost analysis. Also note that for maintenance treatments that are typically applied more than one
time in a year (e.g., blading), the cost that should be entered is the cost associated with one
application of that maintenance treatment (i.e., the cost associated with one blading).
Applying South Dakota Default Treatment Timing and Cost Information
If a user does not have the data necessary to populate all initial construction/last major
rehabilitation cost and maintenance costs and frequencies for the various surface types they wish
to analyze, the tool can provide sample default costs and timings. These default values are
summarized in tables 2 through 5 and were determined primarily by averaging the data supplied
by the counties that participated in the study; however, some modifications to the data were
made using the expert opinion of the Technical Panel as a reasonableness check. Data were
averaged using 100-point ADT ranges starting at a zero ADT value. The data were
supplemented with expert opinion from the Technical Panel in order to provide reasonable
values for all ADT ranges. Again, it should be noted that the default values provided for initial
construction/major rehabilitation cost do not include the cost of upgrading a road from one
surface type to another. Therefore, if the user wishes to consider upgrade costs in the analysis,
the default cost values must be increased by the appropriate amount.
Table 2. Default construction and maintenance costs for HMA roadways in South Dakota based
upon ADT levels.
Striping and
Marking
Years
Between
App.

Cost
($/
mile)

Patching/
Annual
Maint.
Cost
($/mile)

ADT

Initial
Construction
or Major
Rehab. Cost
($/mile)

0-99

35,000

3

900

5

6,500

21

35,000

5

210

500

100199

35,000

3

900

5

6,500

17

35,000

4

250

500

200299

37,000

3

1,200

4

7,000

20

37,000

4

280

500

300399

37,000

3

1,200

4

7,000

20

37,000

4

280

500

400499

39,000

5

1,600

4

7,300

20

39,000

4

310

500

500599

40,000

6

1,600

4

7,300

20

40,000

4

320

500

600699

43,000

6

1,600

4

7,300

20

50,000

4

360

500

≥ 700

43,000

6

1,600

4

7,300

20

50,000

4

360

500

Crack Seal
Cost
Years
($/
Between
App.
mile)

Seal Coat
Cost
Years
($/
Between
App.
mile)

* All costs are costs per mile.
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Overlay
Cost
Years
($/
Between
App.
mile)

Table 3. Default construction and maintenance costs for blotter roadways in South Dakota based
upon ADT levels.

ADT

Initial
Construction
or Major
Rehabilitation
Cost ($/mile)

Striping and
Marking

Seal Coat
Cost
Years
($/
Between
mile)
App.

Years
Between
App.

Cost
($/
mile)

Patching/
Annual
Maintenance
Cost ($/mile)

0-99

7,000

5

7,000

5

250

530

100-199

7,000

5

7,000

5

250

920

200-299

7,170

4

7,170

4

280

1,250

300-399

7,850

4

7,850

4

370

1,260

400-499

9,180

5

9,180

5

440

1,430

≥ 500

9,540

4

9,540

3

450

3,150

* All costs are costs per mile.

Table 4. Default construction and maintenance costs for gravel roadways in South Dakota based
upon ADT levels.
Blading

ADT

Initial
Construction
or Major
Rehabilitation
Cost ($/mile)

Times Per
Year

0-99

3,700

100-199
200-299
≥ 300

Regravel

Cost
($/mile)

Years
Between
App.

Cost
($/mile)

Patching/
Annual
Maintenance
Cost ($/mile)

17

45

8

3,700

350

3,700

20

45

8

3,700

800

4,500

30

50

6

4,500

1,070

7,036

50

65

6

7,036

2,420

* All costs are costs per mile.

Table 5. Default construction and maintenance costs for stabilized gravel roadways in South
Dakota based upon ADT levels.
Reshape Cross
Section

ADT

Initial
Construction
or Major
Rehab. Cost
($/mile)

Years
Between
App.

Cost
($/
mile)

Times
Per
Year

Cost
($/
mile)

Years
Between
App.

Cost
($/
mile)

Years
Between
App.

Cost
($/
mile)

Spot
Gravel/
Annual
Maint.
Cost
($/mile)

0-99

5,000

1

2,700

4

40

12

2,300

--

--

500

100-199

8,154

1

3,300

4

40

5

4,854

--

--

333

200-299

8,154

1

3,300

4

40

5

4,854

--

--

333

≥ 300

19,716

1

2,300

6

380

10

17,416

10

3,400

3,635

Dust Control

Blading

Regravel

* All costs are costs per mile.
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To apply the average default treatment timing and cost information for a given surface type,
simply click on the button at the bottom of each tab. For example, for the HMA surface type,
click on the
button. After clicking one of the surface-specific
buttons to apply default values, a confirmation pop-up dialog box will appear (see figure 6). The
purpose of this dialog box is to confirm that you want to apply the default values as most of the
currently defined values will be replaced by the default values.

Figure 6. Confirmation dialog box that appears when choosing to apply default maintenance
treatment timing and cost information.
Upon applying the default values, all controls on the current tab that reflect the applied defaults
are shaded yellow (see figure 7). Also, as the default values are ADT-specific, a text box at the
bottom of the tab reminds you what ADT was defined when you chose to apply defaults. Note
that if you return to the General Cost Analysis Setup dialog and change the ADT value, you will
have to click the button again to apply the default values associated with the new ADT value.
After default values are applied, any input value that is changed from the applied default value
will be displayed with a white background. For example, figure 8 shows the same information as
shown in figure 7 except the crack sealing frequency has been changed from “every 3 years” to
“every 4 years,” the start year has changed from 3 to 4 years, and the cost value changed from
$1,200 to $1,300. Note that these changes resulted in the background of those input controls
being changed from yellow to white. Also, note that the background color of the other crack
sealing-related input controls did not change as those values were not changed.
Be aware that when you change your ADT value after you have applied default values for a
different ADT, you will most likely observe a large number of input controls changing
background color. For example, figure 8 shows the HMA tab after ADT was changed from 350
(the defaults shown in figure 6) to 100. The inputs shown in white reflect those current values
that do not match the default values associated with the newly defined ADT of 100. Likewise,
the inputs with yellow backgrounds indicate those current inputs that still match with the defaults
applied for the ADT of 350. Therefore, once you have chosen to apply default values for a given
surface type, it is recommended that you always reapply the default values if you make a change
to the ADT value.
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Figure 7. Example of the Agency Cost Details dialog box after default values have been applied
(showing controls associated with an HMA-surfaced pavement).

Accessing Advanced General Cost Inputs
If the Enable “Advanced User” Inputs check box is checked on the Introduction dialog box, the
button will be visible on the Agency Cost Details dialog box. If the Enable
“Advanced User” Inputs check box is left unchecked on the Introduction screen, this button will
not be visible during an analysis session.
When enabled, clicking on the
button provides the user with access to some of the
underlying defaults associated with the life-cycle cost analysis. Specifically, clicking this button
will display the Advanced General Cost Inputs dialog box shown in figure 10. On this dialog
box, the screen is divided into two areas. The first area, the General Life-Cycle Cost Defaults,
displays the default values utilized for three of the general values associated with the life-cycle
cost analysis. The second area of the screen allows you to include or exclude salvage value.
Details associated with these cost-related inputs are described in more detail below.
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Figure 8. Example of the Agency Cost Details dialog box illustrating how inputs that differ from
the applied default values are distinguished with white backgrounds.
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Figure 9. Illustration of the numerous differences in current values and applied default values
that may result if the ADT value is changed after defaults have been applied.
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Figure 10. Advanced General Cost Inputs dialog that stores general life-cycle cost default values
accessible to advanced users (default values shown).
Setting General Life-Cycle Cost Defaults
The General Life-Cycle Cost Defaults area of the Advanced General Cost Inputs dialog box
provides input boxes so you can alter the following three life-cycle cost-related default values:


Analysis period—The Analysis period specifies the time period over which the cost
analysis is evaluated. Based upon input from the Technical Panel, the default analysis
period was set to 20 years. You can change this value by deleting the current value and
entering a new value in terms of years. Note: A 20-year analysis period is often
considered the minimal range for a life-cycle cost analysis. Analysis periods less than 20
years should not be used without specific reasoning. It should also be noted that the
analysis period is limited to 50 years on the upper end.



Discount rate—By definition, the discount rate is the estimated difference between the
interest and inflation rates over a long period of time, therefore, representing the true time
value of money. The interest rate (or market interest rate) is described as the cost of
borrowing money. The inflation rate is typically defined as the rate of increase in the
prices of goods and services (e.g., construction of highways) over time. In the analysis
tool, the discount rate is used to adjust all user-provided cost values to present worth
dollars. The default value of 3.5 percent, which falls in the commonly quoted acceptable
industry-wide range of 2 to 4 percent, is based upon the recommendations of the research
team and Technical Panel.



Year of analysis—The Year of analysis reflects the base year used in conducting the
analysis. Since the tool was initially developed in 2003, the default costs in the tool are
based upon this date. Documentation of the current Year of analysis is needed so costs
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can be converted to that base date. The tool allows the user to set the year of analysis to
the current calendar year (from the computer’s internal clock) or to a specific user
identified year. If the first radial button is selected, the year of analysis will be
determined based upon the computer’s clock. For example, if the user conducts an
analysis in December of 2004 and the user opened the tool in January of 2005, the
analysis year would be automatically updated to 2005. However, if the user wishes to
keep the analysis year at 2004, the second radial button can be selected and 2004 can be
entered into the Year of analysis input box.
Including Salvage Value
Simply put, a salvage value may be defined as the estimated value of an asset at the end of its
useful life. Within the analysis approach, a salvage value is computed for each included
maintenance treatment used in the analysis. Specifically, a salvage value is computed for a given
maintenance treatment by determining the estimated remaining life of a maintenance treatment at
the end of the defined analysis period, and then “giving back” the cost of the unused life of the
treatment (to accomplish this computation, a linear depreciation approach is used).
For example, let’s assume a $5,000 seal coat is expected to last 5 years, and is applied the year
before the end of the analysis period used in the analysis. Therefore, in practice, the roadway has
only used one of the five years of “benefit” provided with the application of the seal coat.
Therefore, if the user chooses to include a salvage value in the computations, a salvage value of
(4/5) * $5,000 = $4,000 would be applied as a negative cost at the end of the chosen analysis
period. Conversely, if the user had chosen to not include a salvage value, the seal coat would be
assumed to have no value after only one year in place (i.e., at the end of the analysis period).
The default setting is to include salvage value in the analysis. Therefore, by default, the Include
salvage value check box on the Advanced General Cost Inputs dialog box is checked. If you
wish to exclude the salvage value from the cost analysis, simply click the check box to remove
deselect it.
User Cost Details Dialog Box (Optional)
The User Cost Details dialog box (shown in figure 11) provides controls that are used to define
the general inputs required to include user costs (vehicle operating costs and the crash costs) in
an analysis session. Note that this dialog box will only be displayed if you check the Include
user costs (vehicle operating costs and crash costs) check box on the General Cost Analysis
Setup dialog box. The User Cost Details dialog box is divided into two areas: the Vehicle
Operating Costs portion and the Crash Costs portion. Also included in the dialog box is the
ability to access the Advanced Inputs. The details associated with defining these user cost inputs
are discussed below.
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Figure 11. User Cost Details dialog box.

Defining Vehicle Operating Cost Attributes
The Vehicle Operating Costs area of the User Cost Details dialog box includes inputs for both
the Posted speed limit and Terrain associated with the project being analyzed. These inputs are
both required to compute the vehicle operating costs associated with the project (i.e., the costs
incurred by roadway users in the form of increased wear and tear on a vehicle from using the
facility). More detailed descriptions of both of these inputs are the following:


Posted speed limit—The posted speed limit represents the maximum allowed legal speed
at which traffic may travel on the roadway section being analyzed. This information is
needed when computing running costs associated with different vehicle types on a given
roadway section. The units of the speed limit are miles per hour (mph). To change this
default value, simply enter a new value into the provided input box.



Terrain—The Terrain input describes the topography of the land surrounding the given
roadway section. Within the analysis tool, terrain is classified as flat, rolling, or
mountainous. These three terrain descriptions are associated with grades of 0, 2, and 5
percent, respectively. Similar to the Posted speed limit, the Terrain type is needed to
compute running costs associated with different vehicle types on a given roadway
section. To select the appropriate terrain for a given project, select the appropriate value
from the Terrain drop down list box.
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Defining Crash Cost Attributes
The Crash Costs area of the User Cost Details dialog box requires the specification of the
potential for crash occurrence. This information is needed to compute the total crash cost
expected for a given roadway section. Specifically, the total crash cost represents the costs to
society associated with user fatalities, user injuries, or property damage crashes on a particular
section of roadway. You are provided with four categories of crash potential from which to
choose: None, Low, Medium, and High. To select the appropriate crash cost potential for a
given project, choose the proper crash potential from the Potential for crashes drop down list
box.
When choosing the appropriate crash potential for a given project, it is important to understand
the specific characteristics that are used to differentiate between the different levels of crash
potential. To access more detailed crash cost-related information, click on the
button.
button will display a pop up dialog box containing a table of crash
Clicking the
potential guidelines (see figure 12). This table describes the expected number of crashes by type
associated with the different crash potential levels. The guidelines for the number of crashes are
based upon a ten-year time period assuming a 1-mile section of road. The values presented are
based on averages of South Dakota crash data analyzed as part of this project. Crash potential is
provided for a 10-year period even though the analysis period may be different. The crash
potential rates were provided for a 10-year period because it is easier to estimate crash potential
over a shorter time period such as 10 years versus a longer time period such as the 20 years that
might be used as the analysis timeframe. The costs associated with the crash potential selected
will be automatically converted to the appropriate analysis period in the software tool.

Figure 12. Guidelines for crash potential selection.
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Accessing Advanced User Cost Inputs
If the Enable “Advanced User” Inputs check box is checked on the Introduction dialog box, the
button will be visible on the User Cost Details dialog box. If the Enable
“Advanced User” Inputs check box is left unchecked on the Introduction screen, this button will
not be visible during an analysis session.
When enabled, clicking on the
button provides the user with access to some of the
underlying user cost-related defaults associated with the life-cycle cost analysis. Specifically,
clicking this button will display the Advanced User Cost Inputs dialog box shown in figure 13.
On this dialog box, the screen is divided into three areas: Traffic Growth, Traffic Breakdown by
Vehicle Type, and Detailed Crash Location Information. Each of these areas is described in
more detail below.

Figure 13. Advanced User Cost Inputs dialog that stores user cost-related default values
accessible to advanced users (default values shown).
Defining the Traffic Growth Rate
As the vehicle operating costs are directly related to the number of vehicles that travel on a
roadway in a given year, it is important to take the expected annual growth in traffic into
account. Based on feedback obtained from the Technical Panel associated with this project, the
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traffic was expected to grow linearly at a rate of 1.2 percent per year. For example, if a
pavement section were expected to receive 100,000 vehicles in the first year, using a growth rate
of 1.2 percent would result in 101,200 vehicles expected in the second year (i.e., 100,000 *
[1.012] = 101,200). To change the growth rate to something different that the default value,
simply enter a new value in the provided input box.
Defining the Traffic Breakdown by Vehicle Type
Different vehicle types have different operating costs associated with them. Therefore, to get a
more accurate estimate of the total vehicle operating costs expected for a given roadway
segment, it is important to analyze different vehicle types separately. Within the analysis tool,
traffic is divided into five different vehicle types: passenger cars, commercial delivery trucks,
single unit trucks, 2-axle tractor-semitrailer combination trucks (2-S2 trucks), and 3-axle tractorsemitrailer trucks (3-S2 diesel trucks). Based on guidance by the Technical Panel for this
project, the following default percentages of the annual ADT were assigned to each of the five
included vehicle types.






Passenger cars (97 percent).
Commercial delivery vehicle (1 percent).
Single unit truck (1 percent).
2-S2 (2-axle tractor-semitrailer) trucks (0.5 percent).
3-S2 (3-axle tractor-semitrailer) trucks (0.5 percent).

Also, note that if tractor-trailer farm equipment is part of the traffic mix they are best included as
2-S2 (2-axle tractor-semitrailer) trucks. To change any of the five default values, simply enter a
new percent of traffic value in the appropriate input box.
Detailed Crash Location Information
As discussed previously, the user may classify the crash potential for a given roadway segment
in terms of None, Low, Medium, or High. The default procedure is to assign the same crash
potential (i.e., that defined on the User Cost Details dialog box) to all four surface types
available for comparison. However, if you feel that the crash potential would differ depending
on the particular surface type, the advanced user inputs contained in the Detailed Crash Location
Information area of the Advanced User Cost Inputs dialog box allow you to make those
designations.
To assign surface-specific crash potentials, start by selecting the Select surface-specific crash
potentials check box (note: making this selection will override the global crash potential defined
previously on the User Cost Details dialog box). Next, use the provided surface-specific drop
down list boxes to select the crash potential level associated with each. As with the
button in the Crash Costs area of the User Cost Details dialog box, clicking on the
button provided on the Advanced User Cost Inputs dialog box will display a table of crash
potential guidelines (see figure 12).
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Restoring User Cost-Related Default Values
At any time, if you wish to restore the original default values to all of the controls on the
Advanced User Cost Inputs dialog box, simply click on the
button. However, note
that you will lose any changes that you have made to this screen up to that point.
Cost Analysis Results Dialog Box
The general results of the cost analysis are displayed on the Cost Analysis Results dialog box.
This screen is divided into three general areas: Summary of Cost Analysis Inputs, Cost Results
Summary, and Additional Selection Criteria. Each of these areas, along with other general
controls on this page, is described in more detail below.
Summary of Cost Analysis Inputs
In an effort to provide some general feedback to the user on this summary page, a number of cost
analysis-related inputs are displayed in the Summary of Cost Analysis Inputs area. Specifically,
the inputs that are displayed here include the entered road name, road location, ADT, analysis
period, and discount rate. Note, if you did not make any changes to analysis period or the
discount rate under the Advanced General Cost Inputs dialog box (only available to advanced
users) then these two values will be set to the default values of 20 years and 3.5 percent,
respectively.
Because the magnitude of user costs can become very large in comparison to agency costs, the
inclusion of user costs in a cost analysis remains a controversial practice. Therefore, the one user
input included in this Summary of Cost Analysis Inputs area allows you to define how much of
the computed user cost value is included in the cost analysis. If the Include user costs (vehicle
operating costs and crash costs) check box was checked on the General Cost Analysis Setup
dialog box, you will be able to input a desired weighting factor in the provided User cost
weighting factor input box. If that check box was not selected, the User cost weighting factor
input box will be grayed and the user cost weighting factors in the summary table below will
show up as “n/a” (i.e., not applicable).
When activated, to enter an appropriate user cost weighting factor into the provided input box,
first determine what percentage of the total user costs you want to include in your analysis. The
defined weighting factor represents the chosen user cost percentage expressed as a decimal. For
example, if you would like to include 50 percent of the total computed user costs, you would
enter “0.50” into the User cost weighting factor input box. Entering a value of “0.03” would
only use 3 percent of the computed user costs in the analysis. Clicking on the
button will display a table displaying some general guidelines for
choosing a level of user costs to include (see figure 15). It is important to note that these
guidelines are intended as general industry “rules-of-thumb” guidelines as they are not based on
scientific data.
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Figure 14. Example of the Cost Analysis Results dialog box.

Figure 15. General guidelines for selecting user cost weighting factors.
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Cost Results Summary Table
The Cost Results Summary area of the Cost Analysis Results dialog box presents all of the
detailed cost information computed for each surface type included in the analysis. From top to
bottom the following describe the presented cost-related information (note: all costs are
presented in units of dollars per mile):


Line 1: Agency Total Cost—The total cost (in present worth dollars) of all maintenance
treatments scheduled to be applied during the chosen analysis period.



Line 2: Vehicle Operating Costs (VOC)—The total operating costs associated with all
vehicles expected to use the roadway segment over the chosen analysis period. As
mentioned previously, VOCs are based on ADT, surface type, speed, vehicle type, and
road grade. If user costs are not included in the analysis, this value will be zero.



Line 3: Crash Costs—The total cumulative crash costs expected on the roadway segment
over the chosen analysis period. The total crash costs are computed as a function of
surface type and the chosen crash potential level. If user costs are not included in the
analysis, this value will be zero.



Line 4: Total VOC and Crash Costs—This line is simply the sum of the values presented
in lines 2 and 3 of the table (i.e., the total VOC and crash costs, respectively).



Line 5: User Cost Weighting Factor (from above)—This line in the summary table
redisplays the user-defined user cost weighting factor that is defined in the Summary of
User Cost Inputs area of the dialog box.



Line 6: Total User Costs (Weighted)—This line in the table displays the total adjusted
user cost value (i.e., the value from line 4 times the value from line 5). For example, if
the Total VOC and Crash Costs value in the table is $500,000, and the user entered a user
cost weighting factor of 0.20, the total displayed on the Total User Costs (Weighted) line
in the table would be “$100,000” (i.e., $500,000 * 0.20 = $100,000).



Line 7: Total Costs (Agency + User Costs)—This value represents the total present worth
life-cycle costs associated with a given surface type. This is computed as the sum of the
total computed agency cost (line 1) and the adjusted total user costs (line 6).

The most economic surface type for a given project is that which has the lowest total cost in the
summary table (i.e., the lowest cost value presented in line 7). To make the selection of the most
economic surface type more clear, the lowest-cost surface alternative is highlighted in the
summary table. For example, in figure 14, the Blotter surface type is clearly identified as the low
cost alternative for that project.
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Closing the Workbook
You may close the workbook from the Cost Analysis Results dialog box by clicking on the
button. Clicking this button will bring up the Closing the Analysis Workbook dialog
box shown in figure 16. The function of the three buttons provided on this dialog box are
described below.


The
button saves any changes that you have made during the current analysis
session and then closes the analysis tool workbook.



The
button closes the analysis tool workbook without saving any changes
made to the current session.



button returns the user to the user interface. The analysis tool workbook
The
will not be closed, and therefore any input changes will not be lost.

Figure 16. Closing the Analysis Workbook dialog box.

Viewing the Cumulative Costs Chart
Another method of visualizing the cost differences between the different included surface types
is to view the cumulative costs (total of agency and included user costs) over the selected
analysis period. To view a chart showing a comparison of the cumulative costs, click on the
button at the bottom of the Cost Analysis Results dialog box. An example of a
cumulative cost chart is presented in figure 17.
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Comparison of Cumulative Costs Associated with Different Surface Types
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Figure 17. Example of a cumulative cost chart comparing the life-cycle costs associated with
each included surface type.
button to return to the Cost

After viewing the chart click on the provided
Analysis Results dialog box.
Printing the Summary Table and the Cumulative Cost Chart

To print an output report that contains specified inputs, cost analysis tabular output, and the
created cumulative cost comparison summary chart, click the
button. The
specifics of the created output report are described in more detail in the Output section of this
User’s Guide.
Accessing the Additional Selection Criteria
If you want to compare surface types solely on an economic basis, you may stop your analysis
session at this point. However, if you are interested in making the surface type selection based
on a combination of economic and non-economic factors, it is recommended that you click on
the
button in the Additional Selection Criteria area on the Cost Analysis Results
dialog box. Clicking this button will display the Scoring Table for Economic and Non-Economic
Factors dialog box that is discussed in the following section (see figure 18).
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Scoring Table for Economic and Non-Economic Factors Dialog Box
In some cases, an agency may select a local road surface based solely on economic factors.
However, in most cases, there are other issues besides total costs that come into play when
deciding on a roadway surface. These issues include political factors, growth rates, housing
concentration/dust control needs, mail routes, and industry/truck traffic. This section includes
more detailed descriptions of the six different factor categories, describes the use of rating
factors, describes the assignment of scoring factors, and finally, describes the computation of the
total score used to compare different surface type alternatives.

Figure 18. Scoring Table for Economic and Non-Economic Factors dialog box.
Definition of Different Factor Categories
Based on discussions with the Technical Panel associated with this project, six different factor
categories were identified as being influential when selecting the appropriate surface type for a
given alternative. These categories include:


Total Cost.



Political Issues.



Growth Rates.



Housing Concentration/Dust Control.
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Mail Route.



Industry/Truck Traffic.

When evaluating these categories for your given roadway section, you should plan on using only
those factors that apply to your roadway. If for instance, you have a substantial growth in
population for the area surrounding the given roadway you would include Growth Rates as a
factor in your analysis. Likewise, if you have, or are expecting, an increase in industry and
truck traffic in the area of your roadway section, you would consider the Industry/Truck Traffic
factor as a non-economic factor in the analysis. However, if there are no Political Issues relating
to your roadway section you might decide to exclude the factor from your analysis.
Assigning of Rating Factors
The first step in evaluating both non-economic and economic factors simultaneously is to assign
rating factors associated with each of the six different factor categories. These rating factors
represent the relative (weighted) importance of the six factors considered in the selection
process. That is, those factors that are more important in an agency’s decision process should
have a higher rating factor. All assigned rating factors must add up to 100 percent.
If the user desires more guidance on selecting rating factor, they may click on the
button and a table displaying some general guidelines for choosing a rating
factor will be provided (see figure 19). It is important to note that these values are intended as
general guidelines to aid the user and are not based on scientific data.

Figure 19. General guidelines for selecting rating factors.
In the example shown in figure 18, the user has identified the Total Cost factor category as the
most important of the six categories as the largest single weight (55 percent) was assigned to this
category. The least important categories were Mail Routes and Industry/Truck Traffic as they all
were assigned the same weigh of 5 percent with Growth Rates receiving no rating.
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Assigning Scoring Factors
The second step in the evaluation is to assign scoring factors associated with each factor
category/surface alternative combination. For each rating factor, the scoring factor identifies
how well the treatment alternative addresses that rating. Scoring factors are assigned on a 1 to 4
point scale. Within a given factor category, the higher the assigned scoring factor, the more
appropriate that surface type would be if only that factor category were being considered.
For example, let us assume that you are conducting an analysis in which you are considering
three different surface types: HMA, blotter, and gravel. In the process of assigning scoring
factors, you would start with the Total Cost category. For the given project, you would ask
yourself “how do the costs of the three considered surface alternatives compare?” Let’s assume
that your cost analysis showed that blotter was expected to have the least cost. HMA was the
next least expensive of the three alternatives, although its cost was very close to the cost of the
blotter alternative. Finally, let’s assume that the gravel surface type was found to be nearly twice
as expensive as the blotter alternative. Therefore, in the Total Cost row of the scoring table you
might assign a scoring factor of 4 for blotter as it was found to the least expensive. Since the
cost of more expensive a value of 3 may be the most appropriate score for HMA. Finally, since
gravel was found to be nearly twice as expensive as both the blotter and gravel alternatives, a
scoring factor of 2 might be the most appropriate value for the gravel surface type and stabilized
gravel would receive a scoring factor of 1 because it was over nearly four times as expensive as
the blotter surface. Note that the same scoring factors can be assigned within a given factor
category (e.g., in the previously described example, the HMA and gravel alternatives could both
be assigned a scoring factor of 2 if their costs were very close). To complete the scoring table,
continue assigning scoring factors for each of the six different factor categories.
Comparing Surface Types Using the Computed Total Score
After rating and scoring factors have been assigned, the final step of the evaluation is to calculate
the total scores associated with each surface type. For each factor category/surface type
combination, a score is computed by multiplying the assigned scoring factor times the associated
rating factor. For this calculation, the rating factor, which previously was given as a percentage,
is now expressed as a decimal (e.g. 10 percent = 0.10). For example, in the Total Cost row
shown in figure 18, the cost component to the total score of 1.65 for an HMA surface is
computed by multiplying the 55 percent rating factor for total cost by the assigned scoring rating
of 3 (i.e., 0.55 * 3 = 1.65).
A total score is computed for each surface type by summing the individual contributions to the
total score determined for each factor category. The surface type with the highest overall total
score is then identified as the most appropriate surface type when both non-economic and
economic factors are considered together. In the example shown in figure 18, the blotter surface
type was determined to be the most appropriate surface type since it had the highest total score of
3.55. Note that the surface type with the highest overall score is highlighted in the Scoring Table
for Economic and Non-Economic Analysis dialog box to clearly indicate the most appropriate
surface type based on the user-defined ratings and scoring factors.
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Printing the Scoring Table Results
To print an output report that contains results of the scoring table, click the
button. The specifics of the created output report are described in more detail in the Output
section of this User’s Guide.
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5.0 OUTPUT
As indicated in previous sections, two different output reports may be printed from the analysis
tool. Specifically, these two output reports include the primary output report and the Scoring
Table for Different Factor Categories. Both of these outputs are described separately in more
detail below.
Primary Output Report
The primary output report summarizes all general cost-related inputs, a table of cost summary
results, and the chart showing the cumulative costs over time for each of the included surface
type alternatives. As indicated previously, this output report is printed by clicking on the
button in the Cost Analysis Results dialog box. Each of the different parts of this
output report is briefly described below.
Input Table
The first part of the output report is a table that summarizes all of the important cost-related
inputs defined by the user during the analysis setup steps. Specifically, all of the inputs
associated with the project description, general analysis setup, maintenance treatment timing and
costs, and user costs are summarized. If the advanced user options were enabled during the
analysis session, a summary of all advanced user inputs will also be displayed.
Cost Summary Results Table and Chart
The second part of the primary output report is a table that summarizes all of the cost
calculations (see table 6) for the analysis. The Cost Summary Results table is divided into
agency cost and user cost details and shows all of the computed costs associated with the various
surface types included in the analysis. All costs in the table are summarized in present worth
dollars per mile of roadway based upon the analysis period and discount rate specified in the
analysis setup. In addition to the table of cost summary results, this page of the primary output
report also contains a chart that compares the cumulative costs for the various surface types in
the analysis (see the example chart previously shown in figure 17). Based solely on costs, the
most cost-effective surface type is that surface that provides the lowest total cost over the chosen
analysis period.
Scoring Table for Different Factor Categories
If a user decides to consider non-economic factors, rating and scoring factors will be assigned to
all surface types and final scores will be calculated and provided in tabular format in the software
tool. As indicated previously, this scoring table may be printed by clicking on the
button in the Scoring Table for Economic and Non-Economic dialog box. An
example of this tabular output is shown in table 7. The surface with the highest overall score is
considered the appropriate surface type for the given set of circumstances for the road section.
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Table 6. Example cost summary results contained in the primary output report.

COST SUMMARY RESULTS

Cost Type
Initial Cost
Maintenance Costs
Salvage Value

AGENCY COST SUMMARY
Unit Costs ($/mile) for Different Surface Types
Stabilized
HMA
Blotter
Gravel
Gravel
$37,000
$7,850
$7,036
$19,716
$55,344
$45,625
$94,752
$141,973
$20,409
$3,098
$1,768
$9,415

TOTAL AGENCY COSTS

Cost Type
Vehicle Operating Costs (VOC)
Crash Costs
Total VOC & Crash Costs
User Cost Weighting Factor
TOTAL USER COSTS (Weighted)

$71,935

$50,376

$100,020

$152,274

USER COST SUMMARY
Unit Costs ($/mile) for Different Surface Types
Stabilized
HMA
Blotter
Gravel
Gravel
$318,226
$370,039
$473,664
$421,851
$181,670
$145,420
$38,920
$73,430
$499,896
$515,459
$512,584
$495,281
0.125
0.125
0.125
0.125
$

62,487

$

64,432

$

64,073

$

61,910

TOTAL COST SUMMARY
TOTAL COST (Agency + User)

$134,422

35

$114,809

$164,093

$214,184

Table 7. Example scoring table for the simultaneous comparison of both economic and non-economic factor categories.

Scoring Table for Different Factor Categories
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Factor Categories
Total Cost
Political Issues
Growth Rates
Housing Concentration/
Dust Control
Mail Routes
Industry/Truck
TOTALS

Score Calculations for Different Surface Types
Blotter
Gravel

HMA

Stabilized Gravel

Rating
Factor
(%)
55
25
0

Scoring
Factor
3
4
4

Computed Total
Score
3 x 55/100 = 1.65
4 x 25/100 = 1.00
4 x 0/100 = 0.00

Scoring
Factor
4
3
3

Computed Total
Score
4 x 55/100 = 2.20
3 x 25/100 = 0.75
3 x 0/100 = 0.00

Scoring
Factor
2
1
1

Computed Total
Score
2 x 55/100 = 1.10
1 x 25/100 = 0.25
1 x 0/100 = 0.00

Scoring
Factor
1
2
2

Computed Total
Score
1 x 55/100 = 0.55
2 x 25/100 = 0.50
2 x 0/100 = 0.00

10

4

4 x 10/100 = 0.40

3

3 x 10/100 = 0.30

1

1 x 10/100 = 0.10

2

2 x 10/100 = 0.20

5
5
100

4
4

4 x 5/100 = 0.20
4 x 5/100 = 0.20
3.45

3
3

3 x 5/100 = 0.15
3 x 5/100 = 0.15
3.55

1
1

1 x 5/100 = 0.05
1 x 5/100 = 0.05
1.55

2
2

2 x 5/100 = 0.10
2 x 5/100 = 0.10
1.45

